
 

Contractors’ First steps to take using the MyLCM System for  
Seattle Housing Authority (SHA) 

 
STEP 1 – Registering: 
 
Go to: https://app.mylcm.com 
 
Click the Registration button to continue.  

 
 
Note: You will need to select Seattle Housing Authority (SHA) as the Agency you will be working for. 
Your company only should register once. 

Make sure your email address is spelled correctly; it will be your username. 

 Password should contain at least 8 characters with at least one number and one special character. 
Example: !SHA2011 

You will not see projects until you have contacted SHA to assign a project to you. 
 

STEP 2 - Adding Users See Section 3.2 in the user manual to add users to the account. 

 
From the Admin menu, select “Manage Users” 
On the User List screen, click the “Add New” button. This will open a new window. 

 

 
 
Select all applicable Groups. 

Select all applicable roles.  If you choose “Company Admin,” you do not need to select any of 
the other options since Administrators have complete access to the application. 

 
Supply a user ID (should be email address), password, user’s full name and title.  These fields 
are mandatory for all users. 

Signature question and answer are only required when you check “Change Password?”  

https://app.mylcm.com/


Note: All User IDs should be e-mail addresses.  If the password is lost, the 
system can send an e-mail to this address. 

 
 

Step 3- Manage Company Classes and Crafts - See Section 3.5 in the user manual 

 
From the Company menu, click on the “Manage Company Classes and Crafts” option. 

Note:  This is to reduce the list of available crafts and counties in the CPR date entry 
screen. 

 
 

From the “Available Crafts and Classes” table on the left, highlight the applicable craft and 
county then click the “>” button.  This will create the list of “Selected Crafts and Classes” on the 
right side of the screen.  

 
 
Click on “Save.” 
 

 
 
 

  



STEP 4 - Manage Employees – See Section 3.6 in the user manual 

From the Company menu, select the “Manage Employees” option. The next screen will be the 
“View Employee List” screen. 

 

Click on “Add New” to add an employee, a screen with two tabs will appear. 

o Employee Information 

o Craft and Classes 

 

Note:  The mandatory fields must be complete prior to submitting employee data.  These 
fields’ text is in bold. 

After completing the employee information, click on the “Crafts and Classes” tab. 

Select the job class(es) and that this individual works.  This list is generated from the selected 
Classes and Crafts identified in the previous section.  It is preferable to always default the 
employee’s craft; identify the default craft by clicking on the “Default” checkbox. 

Note:  This is to reduce the list of available class and crafts in the CPR date entry screen. 

Each employee may only have one default craft. 

 
After completing the employee, crafts and counties information, click “Save” If everything was 
entered properly the computer will indicate, “Employee has been successfully added/updated!” 

 

 
 
Repeat these steps for each employee who needs to be added to the system.   
Note: Employees may be added at any time during the project by repeating this process. 



STEP 5 - Adding Fringe Benefit Packages (If Applicable) See Section 3.9 in the user manual 

 
In addition to the basic hourly rate, contractors are generally required to pay fringe benefits 
either to an employee directly (in cash) or to funds on the employee’s behalf.  The application 
has a set of standard fringe benefit categories (such as health & welfare, training, and vacation) 
as well as fields for other benefit types.  The sum of each of the fringe benefit categories and 
the basic hourly rate equal the total hourly rate paid to the employee.   

Fringe Benefit Packages – these are project specific compensation packages for a particular 
group of employees on the project.  Contractors must create Fringe Benefit Packages for each 
of your projects.   

Click “Manage Fringe Benefit Package” from the Company menu.  This will open the Manage 
Fringe Benefit Package screen. 

 

Click the “Add New” button to create a new Fringe Benefit Package for this project.  The Benefit 
Package Summary screen will open. 

  

Provide a name to describe the Fringe Benefit Package. 

Indicate the effective date and expiration date of this fringe benefit. Provide the standard, 
regular time, swing time, graveyard, overtime, double and triple time hourly rates for the 
package. 

For each fund provide the straight time, regular time, swing time, graveyard, overtime, double 
and triple time rate for each fund and hourly rate.   

Review to ensure that all the information is complete and then click “Save.” 

 

STEP 6 - Defining Fringe Benefit Package Associations (If Applicable) See Section 3.10 in the 
user manual 

Defining Fringe Benefit Package associations allows users to link Fringe Benefit Packages to 
particular crafts and/or employees for defaulting purposes.  Each employee and each craft may 
only be associated with a single Fringe Benefit Package.  However, on the certified payroll 
report screen, users will have the opportunity to select a Fringe Benefit Package other than the 
default.   

To define Fringe Benefit Package associations: 



Click “Manage Fringe Benefit Packages” from the Company menu.  This will open the Manage 
Fringe Benefit Package screen. 

 

Locate the Fringe Benefit Package for which you want to define associations and click the 
“Define Associations” link.  This will direct your web browser to the Define Associations screen. 

 

The Define Associations screen is divided into two columns.  The column on the left lists all of 
the company identified crafts and classifications.  The column on the right lists all of the 
employees stored in the application.  Select all employees and/or crafts that will default to this 
Fringe Benefit Package by checking the box next to the name and click “Save.” 

Note: if the individual or craft is already associated with another package, the name will 
be in gray and the associated Fringe Benefit Package will be listed below.  You may still 
select this, but it will replace the existing association with the new one. 

For defaulting purposes, the application first checks to see if an employee has a default 
benefit package.  If so, the application will apply that package.  If not, the application will 
check to see if the employee’s craft has a default Fringe Benefit Package and apply that 
package. If neither condition is met, then the Fringe Benefit Package will not default. 

   

 

Step 7 - Manage Fringe Benefit Statement (if Applicable) See Section 4.3 (You will not be able 
to create a CPR in the CPR Data Entry field unless this step has been done.) 

In order to manage the Fringe Benefit Statements you must make sure that you have had define 
a Fringe Benefit Package Association, See section 3.10) 

From the Project Menu, select “Manage Fringe Benefit Statement.” Click on “Add New.” 



 

Check the box to which Package Name you would like to select. 

Click on Submit. 

 

 

Click on sign located at the bottom of the page and enter the signature password. 

 

 

Click on “Submit.” 

 

 

You will return to the Fringe Benefit Statement Screen. 

 

 

 

 



STEP 8 - Assigning Subcontractors (If Applicable) See Section 4.2 in the user manual 

A subcontractor has to be assigned to a project prior to submitting certified payrolls.   

Select a project to which you need to assign subcontractors. 

Select from the Project menu “Assign Subcontractor.”  These firms will be expected to enter 
weekly payrolls. 

Note: The Agency must assign first-tier /Contractor/Subcontractors before contractors 
can assign their own subcontractors. If the project(s) is not listed, contact GEFA to 
determine the status. 

 

  

A new screen will appear showing a list of available subcontractors and a list of assigned 
contractors.   

If a subcontractor does not appear on the list, please contact subcontractor and have 
them register with MyLCM. 

  

Enter the contract value into the contract amount box.   

Save the assignment by clicking on “Submit.” 

 

 

STEP 9 - CPR Submittal Process, See Section 5.4 in the user manual 

Select a project 

From the Payroll menu, scroll down and select “CPR Data Entry”. This will direct your web 
browser to the Employee Selection Screen. 



 
 

Select the weekending date of the CPR.   

Note: Once the initial CPR report weekending date is selected, all other weekending 
dates will limited to those using the same week day for the weekending date.   

Click on the boxes to the left of employee who worked on this project for the weekending date 
indicated above.   

Note: If any employee performed classification during the week, please indicate the 
number of counties in the box to the right of the employee’s name. This will create an 
additional record for this employee on the CPR. Leaving this box blank assumes that the 
employee only performed a single craft during the week. 

 
Indicate by checking the box if this is the last certified payroll report for the project.  

Once the above steps are completed, click “Save.” This will direct your web browser to the CPR 
Employees Screen. 

 
Each of the employees who were selected on the previous screen will be listed.  The red light 
indicator to the left of their name indicates that their record is incomplete.  To complete the 
record, double-click on the red signal light.  This will direct your web browser to the Employee 
CPR Record Screen.  



If at any time you realize that you need to add another employee record, you may do so 
by clicking the “Add New” button on the CPR Employees Screen.  Similarly, you may 
delete an employee record by clicking the “Delete” link to the right of the employee 
name. 

click “Save” to save this record.  If you are missing any mandatory information, a pop-up window 
will appear, indicating what is missing.  You must complete all mandatory information in order to 
save the record. 

Upon saving, your browser will be redirected to the CPR Employees Screen.  The stoplight next 
to the completed employee record will become green, indicating that the record is complete.   

Once all of the employee records are complete (marked with a green light), the certified payroll 
report is ready to be previewed.  Click the “Preview” button to see the completed CPR.  Review 
it to ensure all of the data is correct.  Click the “Back” button to return to the CPR Employees 
Screen.  

If everything looked correct, click the “Submit” button.   

Click on “Next” if things look reasonable.  This will direct your web browser to the Statement of 
Compliance. 

Click on “Sign” to electronically sign the report.  A new window will open.  Type in your signature 
password and click “Sign.” 

 

 

 

Note: All passwords are case sensitive. 

If you see a box containing a circle, triangle, and square, it means you haven’t yet 
uploaded your electronic signature file.  See Company-Edit User, Section 3.3. 

Click “Submit” on the Statement of Compliance to complete the Certified Payroll and submit it to 
The City.  The prime, and any other firm which may have hired your firm, will also be able to see 
you payroll to know that is completed. 



 

 

 
 
Upon saving, your browser will be redirected to the CPR Employees Screen.  The stoplight next 
to the completed employee record will become green, indicating that the record is complete.   

Note: The CPR is considered a “Work in Progress” from the time it is started until it has 
been submitted.  If you cannot complete a CPR in a single session, you may log back in 
to the application and complete it at a later time.   

Completing a “Work in Progress” CPR 

From the time that you start the certified payroll report until you submit it, it is considered a work 
in progress.  If you are unable to finish a work in progress in a single log-in session, you may 
return to it at any time.  Unfinished work will not appear on the CPR Log until submitted. 

To continue working on a work-in-progress payroll: 

Select a project, refer to section 2.4 for which a CPR needs to be prepared.  

From the Payroll Reporting menu, scroll down and select “CPR Data Entry”. 

This will direct your web browser to the Work In Progress screen. 

Note: If you do not have any works in progress, then clicking Manual Submit will direct 
your web browser to the employee selection screen as indicated in Section 5.4. 



 

 

 

Figure 1 - Work In Progress Screen 

Click on the “Weekending Date” payroll shown. 
Complete each of the CPR records according to the instructions in section 5.4. 

 

STEP 10 - Submittal of Non-Performance , See Section 5.7 in the user manual 

Contractors must account for each week of the project from the time they start work until they 
have completed the project.  For those weeks when they are not performing work on the project, 
they must submit a Non-Performance Report.  This report merely indicates that for a particular 
week, the contractor did not have any prevailing wage employees performing work on the 
project. 

To submit a Non-Performance Report: 

Select a project, refer to section 2.4 for which a CPR needs to be prepared.  

From the Payroll Reporting menu, scroll down and select “Non-Performance CPR”. 

Select the weekending date from the dropdown list and click “Submit.”  This will direct your web 
browser to the Statement of Non-Performance screen.  

Note: If the non-performance report is the last report for this project, check the box 
indicating “last CPR.” 

 

 

To sign the report electronically, click the sign button. A new window will appear asking for the 
signature password. Enter the password and click “Sign.” This window will close, and an image 
of the signature will appear on the Statement of Non-Performance. 

Note: All passwords are case sensitive. 



  

 

Click “Submit” to complete this process and submit the report.   You will return to the CPR Log 
for this same project.   

Note: Non-performance reports do not require The City’s approval. 

 

 
Once you have been assigned to a project, the Help menu will appear and you may 

download or print the user manual. 

 
 

 
 


